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CHAPTER 1. DAM DESIGN 

The Dam module is used for the design of earth and rockfill retaining structures. Dam is used to 
calculate fill and excavation volumes of a dam as well as the surfaces of foundation treatment.  
 
Dam uses a Graphical User Interface (i.e. with windowing) that is compatible with Microsoft 
Windows 7, 8 and 10. Dam uses the Geo, X3D and SM2 libraries created by Sobek 
Technologies Inc. for data editing, the definition of the presentation style, and viewing and 
editing graphic results. Please refer to the guides of Geo, X3D and SM2 (chapter 2 of the Site 
guide) for all details. 
 
 

1.  LAUNCHING THE DAM MODULE 

Double-click on this icon to open the Dam module.  
 
The connection to the database can be done directly when calling Dam by entering the following 
string as target. The string will be:  
C:\Geotec80\Bin\Dam.exe username/password@odbc:connection_alias  
  
See paragraph 1 of chapter 2 of the X3D guide for all the details about the connection to a 
database.  Once the connection to a database is done, the user can execute a data query to 
produce the plan view as well as the cross sections and longitudinal section.  
 
When Dam is first launched, the following files are loaded from C:\Geotec80\Style: 

• the markers file geotec8.mrk; 

• the patterns file geotec8.ptn; 

• the style file Dam_4Graphs.sty which is a classic presentation model showing a plan view, 
a longitudinal section and two cross sections. 

 
The user can begin working with this initial presentation, or open another style file included with 
the software.  He can modify the style file and save it in a new presentation.  In subsequent 
loadings, Dam opens the style, markers and patterns files that were in use when Dam was 
closed.  
 
 

2. FILE, EDIT, INSERT, WINDOW AND HELP MENUS 

None of the options of the File, Edit, Insert, Window and Help menus is specific to Dam.  The 
detailed description of each option of these menus is done in chapters 2, 3, 4 and 8 of the X3D 
guide.  
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3. VIEW MENU 

The 2D View and 3D View options of the View menu and this button are used to change the 
view of the PLAN_VIEW graph. In the axes editing window, it is possible to change from 2D to 
3D view and vice-versa for PLAN_VIEW.  For the other graphs, the box cannot be checked.  
 
The OpenGL mode can be used to view solids and surfaces with hidden lines and faces and 
shadows in 3D.  The XVT mode is the standard display mode.  
 
 

4. TOOLS MENU 

The options of the Tools menu are used to define the utilisation parameters of Dam and to edit 
the graphic components produced by Dam: the characteristics of the graphic page, the graphs 
and their curves, the axes, the markers used.  All these options are described in details in 
chapter 6 of the X3D guide.  
 
Options is specific to Dam. It is presented in paragraph 4.1.   
 

4.1. Options 

The Options item of the Tools menu or this button opens the window of options for display and 
calculation, shown in figure 1-1, where the user can define the default values used for the 
calculation of the cross sections as well as the parameters for the display of the cross and 
longitudinal sections and the plan view.  
 
4.1.1. Length of the calculated sections 

The field Maximum distance for cross section calculation is used to define the length (in m) 
over which the cross sections will be calculated on both sides of the dike’s center line. The 
distance is expressed: 

• In the plan view, where each cross section is represented by a line more or less long 
(depending on the scale), when the user starts the calculation of a cross section or a 
volume. 

• In the two cross sections, where the X axis’s length is the maximum calculation distance 
on both sides of the origin, i.e. the dike’s axis. 

The step for the tick marks on the X axis adjusts automatically depending on the length to 
represent. 

If the distortion of the Y axis is imposed at 1, the step on the Y axis is also adjusted 
according to the calculation distance to keep the good proportions. 

• When the calculation distance is modified, the changes to the scale will be visible as soon 
as other sections are calculated (clicked).  

 
If a distance is entered in the dike definition, it has precedence over the one specified in the 
options window.  
 



 Dam Design 1-3 
 
 

Tools menu 2019-09-27 
 

 

4.1.2. Minimum spacing between points 

The minimum spacing between points for section calculation is the minimum interval (in m) 
at which the elevation of the points is calculated, between the minimum and maximum X. For 
example, with a value of 2 m, the Z will be calculated every 2 meters. 
 
If a spacing is defined in the dike definition, it has precedence over the one specified in the 
options window. 
 
4.1.3. Height of the representation of the cross sections  

The height of cross section in the longitudinal profile is used to define the percentage of the 
height of the longitudinal profile that the segments displayed at the chainage of the turning 
points of the axis, of each typical section and of the two cross-sections, will occupy. The 
segments are centered vertically in the profile. 
 

 

Figure 1-1 - Display and calculation preferences 
 
4.1.4. Color of the dike zones 

Depending if the radio button selected is Components or Materials, the zones of the dike will 
have as colors the ones defined with the components or with the materials (see descriptions in 
chapter 2). Please note, the stratigraphic horizons always have as colors the ones defined in the 
materials.  
 
If the box with filling is checked, the zones of the dike, the stratigraphic horizons and the 
reservoir will be filled with the colors of the components or the materials, in the cross sections 
and the longitudinal section. 
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If the box is not checked, only the limits of the zones of the dike, the stratigraphic horizons and 
the reservoir will be drawn with the colors of the components or materials.  
 
4.1.5. Display of the construction steps 

By checking the box Display construction steps, the display of the cross sections is done line 
by line. A message indicates which stratum is drawn at each step, to which the user must click 
“next” to see the next step. By canceling, the construction is displayed immediately, without 
showing the following construction steps.  
 
4.1.6. Display of the cartographic file 

By checking the box Display cartographic file, the site map entered in the FILE_NAME field of 
the SITE table will be displayed in the plan view, if a file with this name and of .sit extension is 
found in the input files directory or if the complete path is specified in the field FILE_NAME. 
 
4.1.7. Display of another file 

The user can also display another file in the plan view by selecting the box Display file with 
extension. To its right, the scrolling list shows the extension of all files in the input files directory 
beginning with the name of the file specified in the FILE_NAME field of the SITE table. The user 
selects the extension of the file to display. 
 
For example, if the file name specified for the site is Tailings, the extension of all files starting 
with Tailings in the directory of input files will be in the scrolling list, such as _rock.dtm for the file 
Tailings_rock.dtm. 
 
4.1.8. Display of the embankment 

By checking the box Display embankment, the embankment calculated with the volume 
calculation (.dam file) will be displayed in the plan view for the selected dike. 
 
4.1.9. Display of the cross section 

By checking the box Display cross sections, the segments, markers and text representing the 
typical sections and the cross sections will be displayed in the plan view, with the attributes of 
the Geometry, Section_1 and Section_2 curves of the PLAN_VIEW graph (see paragraph 
5.1). 
 
If the plan view is in 3D, the calculated cross sections are displayed with the colors of the 
components or materials (see paragraph 4.1.4).  After a volume calculation, all the cross 
sections used for the calculation are displayed, until the user clicks at a certain chainage in the 
plan view or in the longitudinal section to calculate a cross section. 
 
 

5. ORGANIZATION OF A GRAPHIC OUTPUT 

The definition of graphs is established and updated in the graph editing window opened by 
selecting the Graphs… option of the Tools menu or by clicking this button. More details about 
the graph editing are available in paragraph 3 of chapter 6 of the X3D guide.  Figure 1-2 shows 
the graph editing window in Dam.  
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The table in this window contains all the graphs defined in the style file used.  Each graph is 
identified by a unique number in the # column. The first graph is always Page with # 0.  This 
graph represents the graphic page and cannot be deleted.  
 
All the other graphs are primary graphs, and the value in their #P cell is 0. The next four 
graphs are identified by their number.  

• #1 always shows the PLAN_VIEW, for the display of a plan view.  

• #2 always shows the LONG_SECTION, for the display of the longitudinal section of the 
foundation along the axis. 

• #3 always shows the CROSS_SECTION_1, for the display of a first cross section of the 
dike.  

• #4 always shows the CROSS_SECTION_2, for the display of a second cross section of the 
dike.  

 
For the primary graphs, the Left, Width, Right, Bottom, Height and Top fields define their 
position and dimension; the user can modify these values.  
 

 

Figure 1-2 - Graph editing window 
 

5.1. The PLAN_VIEW graph 

The PLAN_VIEW graph shows the plan view of the site. It is always numbered #1. The plan 
view displays the dike retrieved with its associated axis. One or two topographic backgrounds 
as well as the cross sections can also be displayed. See the options for display and calculation 
in paragraph 4.1. Figure 1-3 shows the predefined curves of the PLAN_VIEW graph. The 
display of these curves is not affected by their type. 
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Figure 1-3 - Predefined curves of the PLAN_VIEW graph 
 
The Axis_Points curve (#100) shows, for the axis of the selected dike: 

• markers at its turning points; these markers are different from the end points of the axes; 

• a line passing through its turning points; this line merges with the outline of the axis except 
in the curved sections; 

• the attributes that can be modified for the Axis_Points curve are the line and the marker. 
 
The Axis_Curve curve (#101) shows, for the axis of the selected dike: 

• its outline; this line follows the eventual curves defined by a radius at some turning points;  

• its identification; the name and symbol of the axis are displayed at both ends of the axis; the 
orientation of the text shows the origin of the axis: in reading position, the origin is left. 

the marker used for the axis in the one in the current markers file whose name is the 
concatenation of the type and state of the axis, for example, LS_R for a realised seismic 
line. If no corresponding marker is found, the one defined for the Axis_Curve curve will be 
used. The color and dimension of the markers can always be modified.  

• the attributes that can be modified for the Axis_Curve curve are the line, the text and the 
marker (color and dimension, the symbol has no effect if there exists a marker for the type 
and state of the axis in the markers file). 

 
The Axis_Profile curve (#102) is not used.  
 
The Geometry curve (#110) shows, for the selected dike: 
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• the location where begins the application of each typical section, by a segment along which 
the name of the typical section is displayed, as well as a marker at its ends. The marker 
VL_P is used by default. 

• the attributes that can be modified for the Geometry curve are the line, the text and the 
marker. 

• in the Options window, the user can decide to display or not the typical sections in the plan 
view (see paragraph 4.1.9). 

 
The Limit curve (#120) shows, for the current site: 

• the rectangular or polygonal limits saved in the database; 

• the attributes that can be modified for the Limit curve are the line and the marker (for each 
corner of the limit). 

 
The Section_1 (#140) and Section_2 (#141) curves show, for the selected dike: 

• the location of the last two calculated cross sections, by a segment along which the name 
of the typical section that is applicable and the chainage are indicated, as well as a marker 
at its ends.  The marker VL_R is used by default.  

The cross sections are calculated when the user clicks at a certain chainage in the plan 
view or in the longitudinal section. 

• the Section_1 curve (#140) shows the last calculated section, and the Section_2 curve 
(#141) shows the penultimate section.  

• the attributes that can be modified for the Section_1 and Section_2 curves are the line, the 
text and the marker. 

• in the Options window, the user can decide to display or not the cross sections in the plan 
view (see paragraph 4.1.9). 

 

5.2. The LONG_SECTION graph 

The LONG_SECTION graph shows the longitudinal section of the foundation along the axis for 
the selected dike.  It is always numbered #2.  Figure 1-4 shows the predefined curves of the 
LONG_SECTION graph. The display of these curves is not affected by their type. 
 
The height of the segments displayed in LONG_SECTION is specified in the Options window 
(see paragraph 4.1.3). 

 
The Axis_Points curve (#100) shows, for the axis of the selected dike: 

• the chainage at which the turning points of the axis are located, with vertically centered 
segments; 

• the axis name and the index of the turning point, along each segment;  

• the attributes that can be modified for the Axis_Points curve are the line, the text and the 
marker. The marker would be displayed at the ends of the segment. 
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Figure 1-4 - Predefined curves of the LONG_SECTION graph 
 
The Axis_Curve (#101) and Axis_Profile (#102) curves are not used.  
 
The Geometry curve (#110) shows, for the selected dike: 

• the location where begins the application of each typical section, by a segment along which 
the name of the typical section is displayed, as well as a marker at its ends. The marker 
VL_P is used by default. 

• the attributes that can be modified for the Geometry curve are the line, the text and the 
marker. 
 

The Section_1 (#140) and Section_2 (#141) curves show, for the selected dike: 

• the location of the last two calculated cross sections, by a segment along which the name 
of the typical section that is applicable and the chainage are indicated, as well as a marker 
at its ends.  The marker VL_R is used by default.  

The cross sections are calculated when the user clicks at a certain chainage in the plan 
view or in the longitudinal section. 

• the Section_1 curve (#140) shows the last calculated section, and the Section_2 curve 
(#141) shows the penultimate section.  

• the attributes that can be modified for the Section_1 and Section_2 curves are the line, the 
text and the marker. 
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5.3. The CROSS_SECTION_1 and CROSS_SECTION_2 graphs 

The CROSS_SECTION_1 and CROSS_SECTION_2 graphs show the first and second cross 
sections of the dam. They are always numbered #3 and #4. Figure 1-5 shows the predefined 
curve of the CROSS_SECTION_1 graph. The display of this curve is not affected by its type. 
 

 

Figure 1-5 - Predefined curve of the CROSS_SECTION_1 graph 
 
The curves Section_1 (#140) and Section_2 (#141) (for the CROSS_SECTION_2 graph) 
show: 

• at the bottom of each cross-section, the name of the typical section that is applicable and 
the chainage of the cross section displayed. 

The cross sections are calculated when the user clicks at a certain chainage in the plan 
view or in the longitudinal section. 

• the attribute that can be modified for the Section_1 and Section_2 curves is the text.  
 

 

6. DATA MENU 

The options of the Data menu are detailed in chapter 7 of the X3D guide. In Dam, the retrieval 
by simple query is done on the Dike table.  
  
In Dam, the data entry options available in the Data menu (Entry option) and with the buttons of 

the application toolbar ( ) are those of Dike, Site, 
Foundation, Reservoir, Axis, Geometry, Typical Section, Materials and Components. 
Refer to chapter 2 for a description of these entry forms specific to Dam.  
 
The Color Selection option is used for the OpenGL mode. See chapter 2 of the Site guide.  
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6.1. Calculation of cross sections 

The Cross-Section option of the Data menu is active once a dike is retrieved. This option is 
used to calculate, at a certain chainage, a cross section of the dike.  
 
Three calculation methods exist, depending on the method defined for the current foundation 
(see the definition of the Foundation entry form in chapter 2). 

• Dam uses the longitudinal profiles defined in the AXIS_PROFILE table of the surfaces of 
stratigraphic horizons along the axis, up to 5, and extrapolates them laterally; 

• Dam uses the longitudinal profiles of the surfaces of stratigraphic horizons defined in .pro 
text files; 

• Dam uses the data terrain models as regular grids (DTM) of the limits of the stratigraphic 
horizons if they are available.  

If the method with DTM is the calculation method, the calculation distance of cross sections 
is taken into account.  This width is read in the dike definition, or in the options window, if no 
value was defined (see paragraph 4.1.1). 

 
To start the calculation of a cross section, the user can: 

• click a point along the axis in the plan view; 

• click the desired location along the longitudinal profile; 

• select the Cross Section option of the Data menu, this button or the Calculate Cross 
Section option of the interactive menu opened with a right click when the cursor is in the 
plan view or longitudinal profile.  

The window shown in figure 1-6 is opened. 
 
The location of the cross section to calculate is shown with a segment perpendicular to the axis 
in the plan view and with a segment vertically centered in the longitudinal view. If the plan view 
is in 3D, the calculated cross sections are displayed with the colors of the materials or 
components (see paragraphs 4.1.4 and 4.1.9).  
 
Dam calculates the geometry of the cross section and displays it in graph #3 
(CROSS_SECTION_1).  If this graph already contained a cross section, its display is 
transferred to graph #4 (CROSS_SECTION_2). 
 
At the bottom of the graphs showing the cross sections, the name of the applicable typical 
section and the chainage of the cross section are displayed.  This information is also displayed 
in the plan view and in the longitudinal profile, along the segments showing the position of the 
last two cross sections calculated.  
 
Figure 1-6 shows the calculation window of cross sections.  The name of the output files is 
automatically the concatenation of the site and dike numbers, but the user can modify it. The 
files are saved in the output files directory, as indicated next to Directory.  
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Figure 1-6 - Calculation of a cross section 
 
Under the Calculation parameters tab: 

• The Calculation distance contains the distance defined with the current dike. If the dike 
definition doesn’t have a calculation distance, then Calculation distance shows the value 
defined in the options window (see paragraph 4.1.1). 

• The Chainage is used to enter the chainage where to calculate the cross section. 

If the calculation window for the cross section was called via the Cross Section option or 
button, the chainage of the middle of the current axis is written in the Chainage field. If the 
window is opened via the interactive menu with the right button of the mouse, the chainage 
of the point clicked in the plan view or in the longitudinal profile is indicated in the Chainage 
field.  
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• The maximum level can be indicated, to calculate only a part of the cross section.  
 

In the File management tab, four files can be produced by checking the corresponding box. 
The buttons to their right open the corresponding files, once calculated. 

• The .sur file is a summary of the cross-section surfaces. 

• The .rps file is a report on the cross section. 

• The .dxf file is a typical cross section in AutoCAD format.  

• The .das file is a typical cross section in SM2 format.  

• The checkbox Save files with every calculation is used to create the files each time the 
Calculate button is clicked.  

• The checkbox Overwrite existing files is used to overwrite the existing files without a 
message being displayed. 

 
The Calculate button launches the cross-section calculation. The results are displayed in the 
table and the Save button is then activated. The Save button is used to save the result files if 
they are not automatically saved (box unchecked). 
 
The OK button saves the calculation parameters (calculation distance) in the dike definition. 
Cancel closes the window without saving the calculation parameters. 
 

6.2. Calculation of volumes and costs 

The Volumes option of the Data menu is active once a dike is retrieved. This option is used to 
calculate, between two chainages, the fill and cut volumes and the costs of backfill and 
excavation. 
 
The volume calculation can be done using the same three methods as the calculation of cross 
sections (see paragraph 6.1). 
 
For the calculation of volumes and costs, Dam determines the chainages for which a cross 
section must be calculated. From the initial to the final chainage, Dam uses the calculation step 
and adds all the chainages where a typical section is defined. The volumes are calculated by 
taking the average of the areas of the components of same type and material and by multiplying 
this value by the difference in chainage between two successive sections.   
 
In the plan view, the calculated embankment and foundation can be displayed, as well as the 
cross sections used (see paragraphs 4.1.8 and 4.1.9), in 2D or 3D. 
 
Remember that the calculation method is defined in the definition of the current foundation (see 
the definition of the Foundation entry form in chapter 2). If the method with DTM is the 
calculation method, the calculation distance of cross sections is taken into account.  This width 
is read in the current dike definition, or in the options window, if no value was defined (see 
paragraph 4.1.1). 
 
To launch the volume calculation of a dike, the user selects the Volumes option of the Data 
menu, this button, or the Calculate Volumes option of the interactive menu opened with a right 
click when the cursor is in the plan view or longitudinal profile. The window shown in figure 1-7 
is displayed.  
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Figure 1-7 - Volume calculation - calculation parameters 
 
The name of the output files is automatically the concatenation of the dike and axis 
numbers, but the user can modify it. The files are saved in the output files directory, as 
indicated next to Directory.  
 
Under the Calculation parameters tab: 

• The Calculation distance contains the distance defined with the current dike. If the dike 
definition doesn’t have a calculation distance, then Calculation distance shows the value 
defined in the options window (see paragraph 4.1.1). 
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• The Initial chainage and Final chainage are used to enter the chainages between which 
the volume calculation will be done. By default, these fields contain the chainages at the 
beginning and end of the current axis.  

• The calculation step contains the spacing between the cross sections that will be 
generated to do the volume calculation. The smaller this value, the more precise the results 
will be but the longer the calculation will take. This field contains the value defined with the 
current dike. If the dike definition doesn’t have a calculation step, then the Calculation step 
takes a value of 20 by default. 

• The maximum and minimum levels can be indicated, to calculate the volumes and costs 
between two elevations. By default, the minimum elevation is the minimum elevation of the 
natural ground on the site, and the maximum level is the crest level. 

• The vertical increment indicates the interval for the volume calculations from the minimum 
to the maximum level. 
 

In the File management tab, shown in figure 1-8, five files can be produced by checking the 
corresponding box. The buttons to their right open the corresponding files.  
 

 

Figure 1-8 - Volume calculation - file management 

• The .vol file is a summary of the volumes of materials. It contains: 

o the excavation volumes by stratum and the fill volumes by material; 

o the unit costs per m3 of excavation and rockfill; 

o the costs, in millions of dollars, of the excavation and rockfill per material; 

o the surface of foundation treatments, cumulated at each calculated chainage; 

• The .rpt file is a detailed report on the volumes. It contains: 

o the excavated volumes per stratum, in m3, cumulated at each calculated chainage; 

o the fill volumes per material, in m3, cumulated at each calculated chainage; 

• The .dam file is a dam embankment in SM2 format.  

• The .ftm file is a filled terrain model. 

• The .xtm file is an excavated terrain model.  
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• The checkbox Save files with every calculation is used to create the files each time the 
Calculate button is clicked.  

• The checkbox Overwrite existing files is used to overwrite the existing files without a 
message being displayed. 

 
The Calculate button launches the volume and cost calculation. The results are displayed in the 
table and the Save button is then activated. The dike span, the embankment and the foundation 
are also calculated. The Save button is used to save the result files if they are not automatically 
saved (box unchecked). 
 
The OK button saves the calculation parameters (calculation distance, calculation step) in the 
dike definition. Cancel closes the window without saving the calculation parameters.  
 
 

7. INTERACTIVE EDITING 

In the plan view and the longitudinal profile, the user can display the interactive menu shown in 
figure 1-9 with the right button of the mouse. When the plan view is in 3D, the interactive menu 
is not available. 

 

Figure 1-9 - Interactive menu 
 

7.1. Tooltip of properties 

If the cursor is on the axis, an axis point or a typical section in the plan view, or on an axis point 
or a typical section in the longitudinal section, a tooltip is displayed, indicating some information 
about the entity. 
 

7.2. Create an axis 

By selecting Create Axis, the cursor takes this format: . Left click at each point of the axis. A 
dotted line shows the movement of the cursor. When the last point of the axis is defined, right 
click to display the pop-up menu and select Cancel to erase the axis being created, or 
Terminate to edit and save the new axis. The axis entry form is then displayed and shows the 
coordinates of each point clicked. The user enters the axis number and any relevant information 
in the entry form, and saves.   

 
7.3. Modify an axis 

Any planned axis (state of axis: P) can be modified with the mouse. When the cursor is on an 

axis, it takes the format . Right clicking opens a pop-up menu. The Information option opens 
the axis editing window on the current axis.  
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By clicking on Add an Axis Point, the cursor becomes . The point will be added between the 
two closest points to the cursor. A message is displayed, showing the exact coordinates of the 
point. To stop the addition of points, right click and select Terminate.  
 
When the cursor is over an axis point and there are more than two points in the axis, the option 
Delete an Axis Point is active. A message is displayed to confirm the deletion of the point.   
 

When the cursor is on an axis point, it takes the format .By clicking on the point, it takes the 

format . Move the point to the desired position, and release the button of the mouse; a 
message is displayed to confirm the move.  
 
Please note: the axis will be displayed in the plan view only if it is associated to the current dike. 
 

7.4. Add a typical section 

The option Add Typical Section of the interactive menu is available in the plan view and the 
longitudinal section. This option opens the Geometry entry form. The chainage clicked is 
indicated. The user can select the name of the typical section to add from the scrolling list.  
 

7.5. Modify a typical section 

The option Modify Typical Section of the interactive menu is available in the plan view and the 
longitudinal section when the cursor is directly on one of the typical sections. This option opens 
the Geometry entry form to modify the chainages and the typical sections used in the current 
geometry. 
 
The user can also directly move a typical section. The cursor takes the format  when it is on 

a typical section. By clicking, it takes the format . Move the typical section to the desired 
position (a dotted line follows the cursor), and release the button of the mouse; a message is 
displayed to confirm the move.  
 

7.6. Delete a typical section 

The option Delete Typical Section of the interactive menu is available in the plan view and the 
longitudinal section when the cursor is directly on one of the typical sections. This option deletes 
the typical section from the current geometry. A message is displayed to confirm the deletion.  
 

7.7. Calculate a cross section or volumes 

These options are described in paragraphs 6.1 and 6.2. 
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CHAPTER 2. DATA ENTRY FORMS 

The entry forms are used for the data entry, modification and deletion in the database. The 
forms are used directly in the Dam module. The forms use the same graphic interface as the 
one used in Geotec.  
 
You will find the description of the generalities regarding the operation of the forms in chapter 1 
of the entry forms guide.  
 
 

1. DIKE 

The Dike entry form is used to identify each dike of a site; information contained in the DIKE 
table.  
 
The key for the records consists of the fields Site and Dike number. 

• Site contains the number of the site to which the dike belongs.  

• Dike number can have up to 20 characters.   

• Foundation indicates the foundation number to associate to the dike. The scrolling list 
shows the foundation numbers defined and belonging to the current site.  

• Reservoir indicates the reservoir number to associate to the dike. The scrolling list shows 
the reservoir numbers defined and belonging to the current site.  

• Axis indicates the axis number to associate to the dike. The scrolling list shows the axis 
numbers defined and belonging to the current site.  

• Geometry indicates the geometry number to associate to the dike. The scrolling list shows 
the geometry numbers defined and belonging to the current site.  

• Description is a field of 255 characters to describe the dike.  

• The downstream level (in meters) can be entered, for information purposes.  

• The camber (in %) can be entered, for information purposes.  

• The calculation step (in meters) is the difference in chainage between two successive 
sections used for the volume calculation.  If no calculation step is defined in the dike 
definition, the one in the volume calculation window will be used.  

• The calculation distance (in meters) defines the length over which the cross sections will be 
calculated on both sides of the dike’s center line. The distance is expressed: 

o In the plan view, where each cross section is represented by a line more or less long 
(depending on the scale), when the user starts the calculation of a cross section or a 
volume. 

o In the two cross sections, where the X axis’s length is the maximum calculation 
distance on both sides of the origin, i.e. the dike’s axis.  

The step for the tick marks on the X axis adjusts automatically depending on the length 
to represent.  
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If the distortion of the Y axis is imposed at 1, the step on the Y axis is also adjusted 
according to the calculation distance to keep the good proportions.  
 

If no distance is entered in the dike definition, the one entered in the options window of 
Dam will be used.  

• The spacing between the points for the calculation of the cross sections (in meters) is the 
minimum interval at which the elevation of the points is calculated, between the minimum 
and maximum X. For example, with a value of 2 m, the Z is calculated every 2 meters.  

If a spacing is not entered in the dike definition, the one entered in the options window of 
Dam will be used.  

 

 

Figure 2-1 - Dike entry form 
 
 

2. SITE 

The Site entry form is used to identify and describe a site and to define the limits of the domain 
it covers; information contained in the SITE table. This entry form is also used in the exploration 
modules and each field is described in details in chapter 2 of the entry forms guide.  
 
The fields of Site used in Dam are: 

• Site, which is a 20-character string. It is the key for the records.  

• The name of the cartographic file, in the Management tab. By clicking on the button to the 
right of the field, the file selection window is opened.  The .sit file with this name in the input 
files directory can be displayed in the plan view.  A second file with the same name as prefix 
can be displayed, if located in the same directory. See the options in chapter 1.  
 

 

3. FOUNDATION 

The Foundation entry form is used to define a foundation and its horizons; information 
contained in the FOUNDATION table and its secondary table, FOUNDATION_STRATA.  
 
The key for the records of FOUNDATION consists of the fields Site and Foundation number. 
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• Site contains the number of the site to which the foundation belongs.  

• Foundation number can have up to 20 characters.   

• The model is the type of terrain model used for the calculation of the strata in the cross 
sections and the longitudinal section. The scrolling list shows four options:  

o DTM uses the numerical terrain models saved in .dtm files.  

The name of each .dtm file must begin with the file name entered in the site definition, 
followed by the “_” character and the name of the foundation strata.  

In the following example, the files would be dike-f_sol.dtm and dike-f_roc.dtm.  The files 
must be located in the input files directory.  

o GRD is similar to DTM, but the files have the .grd extension instead of .dtm.  

o PRO uses .pro files. This option is for future development.  

o MDB uses the data of the AXIS_PROFILE table for the axis associated to the dike. This 
option is for future development.  

• The remark has up to 255 characters.  
 

 

Figure 2-2 - Foundation entry form 
 
In the bottom table corresponding to FOUNDATION_STRATA, the key for the records consists 
of the fields Site, Foundation number and Strata. This table shows each stratum defined for 
the foundation.  

• The stratum number is the order in the foundation from top to bottom. It is an integer.  

• Material contains the material type of the stratum. The list shows all the materials of strata 
type in the MATERIAL table for the SPEC site. A value is required.  

• The excavation batter for the stratum is also required.   

• The other fields are not currently used.  
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4. RESERVOIR 

The Reservoir entry form is used to define several reservoirs for a site, to evaluate different 
levels for example; information contained in the RESERVOIR table.  
 
The key for the records consists of the fields Site and Reservoir number. 

• Site contains the number of the site to which the reservoir belongs.  

• Reservoir number can have up to 20 characters.  

• The freeboard (in meters) is required. It is the difference in level between the maximum 
level of the reservoir and the level of the crest of the dike.  

• The extreme flood level (in meters) is indicated for information purposes only in the current 
version.  

• The maximum level of the reservoir (in meters) is required.  

• The minimum level of the reservoir (in meters) is indicated for information purposes.  

• The length (in km), the surface (in km2) and the volume (in km3) of the reservoir are then 
entered.  
 

 

Figure 2-3 - Reservoir entry form 
 
 

5. AXIS 

The Axis entry form is used to define the axes or cross-sections; information contained in the 
AXIS table. This entry form is also used in the exploration modules and each field is described 
in details in chapter 2 of the entry forms guide.  
 
The fields of Axis used in Dam are: 

• Site, which contains the site number to which the axis belongs.  

• Axis, which can have up to 20 characters.  
 
These two fields constitute the key for the record.  
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Under the Survey points tab, the user can define the turning points of the axes; information 
contained in the AXIS_PI secondary table.  
 
The control points of an axis can be the end points of the axis, the break points of the axis if it’s 
a broken line, and/or the intersection points (PI) to the tangents at the extremities of the curved 
sections.  
 

 

Figure 2-4 - Axis entry form 
 
The key for the records consists of the Site, Axis and Index (I) fields.  

• Index (I) contains the order number of the control points. It is an integer.  

• The UTM X and Y coordinates for each point are then provided; the suggested unit is the 
meter.  The numbers are double precision with 3 decimals by default. Values are required.  

• The radius (R) of curvature at the axis point is 0 if the axis is a broken line, and greater than 
0 if the points is a turning point. The direction of curvature is defined by the position of the 
control points around the current point.  

 
 

6. GEOMETRY 

The Geometry entry form is used to define the geometry of the dike; information contained in 
the GEOMETRY table and its secondary table, GEOMETRY_CH.  
 
The key for the records of GEOMETRY consists of the fields Site and Geometry number. 

• Site contains the number of the site to which the geometry belongs.  

• Geometry number can have up to 20 characters.  
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• A description of 255 characters can be added.   
 

In the bottom table corresponding to GEOMETRY_CH, the key for the records consists of the 
fields Site, Geometry number and Chainage. This table shows the chainage from which the 
typical section applies, as well as the number of the typical section.  
 
A scrolling list with all the normalized typical sections belonging to the SPEC site is available. 
When a typical section is selected, a copy is done for the current site, which can then be 
modified for this specific site.  
 

 

Figure 2-5 - Geometry entry form 
 
 

7. TYPICAL_SECTION 

The Typical Section entry form is used to define the various typical sections used in the 
geometries. The window is split in several zones; the information are contained in the 
TYPICAL_SECTION, FILL, FILL_POINT and CUT tables.  
 
The normalized typical sections belong to the SPEC site. When a typical section is selected in 
the Geometry entry form, a copy of the normalized typical section is done in the current site, and 
this typical section can then be modified without affecting the normalized typical section. The 
materials of type Fill used in the selected typical section are also copied in the MATERIALS 
table for the current site, allowing the user to adjust the color and cost of the materials for each 
project. 
 
The section at the top of the entry form contains the information of the TYPICAL_SECTION 
table. The key for the records consists of the fields Site and Section number. 

• Site contains the number of the site to which the typical section belongs.  

• Section number can have up to 20 characters.  

• The category is used to group the typical sections by family, for example: Bituminous Core; 
RockFill; HOmogeneous; etc. 

• A parent section can be selected in the scrolling list of the typical sections already defined 
to associate a parent section to the current one. Then, a modification to a component in the 
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parent section would also be done in its dependant sections (see the description of the 
Modify column). 

• A remark of 255 characters can be entered.  
 

 

Figure 2-6 - Typical Section entry form - Fill component 
 
The section at the left of the entry form shows the list of fill and cut components forming the 
typical section. The fields in the right section are used to define the selected component. The 
fields vary with the type of component (fill, key trench or toe drain).  

• The first column shows the name of the components. A scrolling list is available for the last 
row of the table (new component) showing the list of components in the COMPONENT table 
that have not yet been defined in the typical section. 

• The Use column allows to use or not each component. To change the value, double-click in 
the cell.  
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If a component is not used, the parameters defining the component are kept, but it is not 
drawn in the typical section or in the cross sections associated to this typical section. If the 
component not being used is a fill component, its space is taken up by the adjacent 
component upstream or downstream, depending if the unused component is upstream or 
downstream.  

For Dam to be able to display a typical section or a cross section, the Upstream 
Embankment component must be defined and used.    

• The Modify column is used for dependent sections. When a component is set to “Modify”, 
any change made to this component in the parent section will also be made in the 
dependent typical section. 
  

The rectangle at the bottom left of the entry form shows the complete typical section, with a flat 
stratigraphy.  
 
The rectangle at the bottom right of the entry form shows graphically the current component. 
The display of this component changes with the modifications of the fields defining the 
component, when the typical section is saved.  
 
In both rectangles, the colors are either the ones of the materials or of the components, 
depending on the selection in the options window of Dam (see the options in chapter 1). 
 
The Component rectangle shows the parameters of each component. Figure 2-6 shows the 
fields of a fill component. The fields are from the FILL table.  

• Zone is an inactive field. It shows the component number, as defined in the COMPONENT 
table.  

• Material contains the material type of the component. The scrolling list shows all the 
materials of Fill type in the MATERIAL table for the SPEC site. A value is required. When a 
material is selected, it is automatically copied in the current site; the color and cost of the 
material in the current site are used.  

• The upper link indicates how the program will extend the upper portion of the component 
below the first specified control point. The options are: 
E : external horizontal link, i.e. towards the dike embankment 
I : internal horizontal link, i.e. towards the center of the dike  
O : oblique link at 45o towards the top and the outside 
U : upward vertical link towards the top of the dike 

• The lower link indicates how the program will extend the lower portion of the component 
beyond the last specified control point.  The options are: 
A : parallel to the acceptable foundation (see next paragraph) 
E : external horizontal link, i.e. towards the dike embankment  
X : parallel to the excavated foundation (see next paragraph) 

• The anchor stratum identifies the foundation strata, i.e. the layer on which the component 
stops. The scrolling list shows all the materials of Strata type in the MATERIAL table for the 
SPEC site.  

The upstream and downstream sides of the core must be anchored to the same layer. If it is 
not the case, the anchor stratum on the downstream side is used if it is shallower than the 
upstream side.  
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The anchor stratum of a component cannot be deeper than the anchor stratum of the 
adjacent inner component. For example, the filter cannot be anchored to a layer deeper than 
the anchor stratum of the core.  

The anchor stratum is not generally used for the riprap, its transitions and the protection 
layers.  

With respect to the lower link, the acceptable foundation is defined by the anchoring of the 
fil type components. The excavated foundation also includes the cut type components.  

• The limit stratum identifies the lowest stratum that the component can reach. A limit 
stratum is only taken into account if a stripping depth is defined. The scrolling list shows all 
the materials of Strata type in the MATERIAL table for the SPEC site. This option is for 
future development. 

• The stripping depth (in meters) is the anchoring depth required for the component. This 
depth is only used if the lower link is A or X. This option is for future development. 

The anchor stratum is excavated based on the depth indicated unless the excavation 
previously reaches the layer indicated in the Limit stratum field. The excavation batter is 
defined in the Foundation entry form for the material of the anchor stratum.   

• The stripping distance (in meters) is the horizontal distance to be stripped following the 
anchor stratum, from the intersection point of the outside limit of the component and of the 
said stratum. This distance is used if the lower link is A or X.  

• The blanket thickness (in meters) is the height of the blanket measured vertically. If this 
field contains a value, the component is extended to create a blanket following the 
acceptable foundation or the excavated foundation. The lower link must be A or X.  

• The foundation treatment takes a value of Yes (Oui) or No. If the foundation treatment is 
done, the costs and surfaces can be calculated.  

 
The last table of the entry form shows the information about the control points, from the 
FILL_POINT table.  

• The point number is required and is entered automatically.  

• The point depth is the depth measured with respect to the crest of the embankment (in 
meters).  A value is required.  

• The point distance is measured with respect to the adjacent component (in meters).  

For the protection components (Riprap, riprap transition, etc.), the distances are 
measured from the outside inwards, from the embankment line, i.e. the outside envelope of 
the dike, or from the outer component. For the other components, the construction is done 
from the dike’s center line, i.e. the distances are measured from the inside outwards, from 
the center line or from the inner component.  

If the distance is not specified, the position of the first point will coincide with the adjacent 
inner or outer component, depending on the component type.  

• The batter from the point indicates the inverse of the slope of the line starting at the point 
and going down, eventually joining the next point.  This value is used if the distance of the 
next point is not defined. Otherwise, the distance specified for the next point will determine 
its position. 
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Figure 2-7 shows the fields of an excavation component, the key trench. The fields are from the 
CUT table.  
 

 

Figure 2-7 - Typical Section entry form - Excavation component: Key trench 

• Zone is an inactive field. It shows the component number, as defined in the COMPONENT 
table.  

• The Distance / H from the center line is used to position the center of the impervious 
section of the key trench with respect to the dike axis. The distance is obtained by 
multiplying the value entered in this field by the hydraulic head, i.e. the upstream water level 
minus the level of the acceptable foundation at the dike center (between excavating the key 
trench). The distance, measured in meters, is positive towards downstream.  

• In the Filling material, downstream drain and its thickness section, the user enters: 

o In Core, the material type of the key trench. The scrolling list shows all the materials of 
Fill type in the MATERIAL table for the SPEC site. When a material is selected, it is 
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automatically copied in the current site; the color and cost of the material in the current 
site are used. 

o In Drain, the material type of the downstream drain of the key trench. The scrolling list 
shows all the materials of Fill type in the MATERIAL table for the SPEC site. When a 
material is selected, it is automatically copied in the current site; the color and cost of the 
material in the current site are used. 

o In Thickness, the perpendicular thickness of the downstream drain of the key trench (in 
meters). 

• In the Width of the base and excavation batter section, the user enters: 

o In Minimum, the minimum width of the key trench, measured horizontally, at the base of 
the excavation. It is the minimum width of the impervious section of the excavation, 
excluding the downstream drain.  

o In Width / H, the multiplication factor of increase of the width at the base of the 
excavation as a function of hydraulic head.  

o In Batter, the excavation batter of the key trench, i.e. the inverse of its upstream and 
downstream slopes. This value is independent of the excavation batters of the layers in 
which the key trench is anchored.  

• In the Anchor stratum, stripping depth and excavation limit section, the user enters: 

o In Anchor, the anchor stratum of the component. The scrolling list shows all the 
materials of Strata type in the MATERIAL table for the SPEC site.  

If an anchor stratum is specified, only the position of this layer controls the excavation 
depth. In this case, the criteria for the minimum and maximum depth and the depth 
relative to the hydraulic head do not apply. 

o In Stripping, the stripping depth to fix the base of the excavation in the specified anchor 
stratum. In this case, the base of the excavation is parallel to the foundation stratum.  

o In Limit, the inferior stratum that the key trench can reach. A limit stratum is taken into 
account only if a stripping depth is defined. The scrolling list shows all the materials of 
Strata type in the MATERIAL table of the SPEC site.  

• In the Excavation depths if anchoring is not specified section, the user enters: 

o In Minimum, the minimum depth of the excavation, i.e. the elevation difference between 
the acceptable foundation and the bottom of the excavation measured at the center of 
the excavation. It is expressed in meters.  

o In Depth / H, the multiplication factor of increase of the depth at the base of the 
excavation as a function of hydraulic head.  

o In Maximum, the maximum depth of the excavation in the case where it is function of 
hydraulic head.  

These three fields are used only when the anchor stratum is not defined. In this case, the 
bottom of the excavation is horizontal. The excavation can then go through one or several 
stratigraphic layers.  

• The Foundation treatment at the base of the excavation takes the value of Yes or No. If 
the foundation treatment is done, the costs and surfaces can be calculated.  
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Figure 2-8 shows the fields of an excavation component, the toe drain. The fields are from the 
CUT table.  
 

 

Figure 2-8 - Typical Section entry form - Excavation component: Toe drain 

• Zone is an inactive field. It shows the component number, as defined in the COMPONENT 
table.  

• The Distance from toe drain to embankment is used to enter the distance between the 
intersection of the embankment with the acceptable foundation and the output point of the 
toe drain.  It is in meters.  

• In the Filling material, downstream drain and its thickness section, the user enters: 

o In Core, the material type of the toe drain’s core. The scrolling list shows all the 
materials of Fill type in the MATERIAL table for the SPEC site. When a material is 
selected, it is automatically copied in the current site; the color and cost of the material in 
the current site are used. 

o In Drain and Thickness are not used.  
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• In the Width of the base and excavation batter section, the user enters: 

o In Minimum, the minimum width of the toe drain, measured horizontally, at the base of 
the excavation.  

o In Width / H, the multiplication factor of increase of the width at the base of the 
excavation as a function of hydraulic head.  

o In Batter, the excavation batter of the toe drain, i.e. the inverse of its upstream and 
downstream slopes. This value is independent of the excavation batters of the layers in 
which the toe drain is anchored.  

• In the Anchor stratum, stripping depth and excavation limit section, the user enters: 

o In Anchor, the anchor stratum of the component. The scrolling list shows all the 
materials of Strata type in the MATERIAL table for the SPEC site. 

If an anchor stratum is specified, only the position of this layer controls the excavation 
depth. In this case, the criteria for the minimum and maximum depth and the depth 
relative to the hydraulic head do not apply.  

o In Stripping, the stripping depth to fix the base of the excavation in the specified anchor 
stratum. In this case, the base of the excavation is parallel to the foundation stratum.  

o In Limit, the inferior stratum that the toe drain can reach. A limit stratum is taken into 
account only if a stripping depth is defined. The scrolling list shows all the materials of 
Strata type in the MATERIAL table of the SPEC site. 

• In the Excavation depths if anchoring is not specified section, the user enters: 

o In Minimum, the minimum depth of the excavation, i.e. the elevation difference between 
the acceptable foundation and the bottom of the excavation measured at the center of 
the excavation. It is expressed in meters.  

o In Depth / H, the multiplication factor of increase of the depth at the base of the 
excavation as a function of hydraulic head.  

o In Maximum, the maximum depth of the excavation in the case where it is a function of 
hydraulic head.  

These three fields are used only when the anchor stratum is not defined. In this case, the 
bottom of the excavation is horizontal. In addition, the excavation can then go through one 
or several stratigraphic layers.  

• The Foundation treatment at the base of the excavation takes the value of Yes or No. If 
the foundation treatment is done, the costs and surfaces can be calculated.  

 
 

8. MATERIAL 

The Material entry form is used to define information about materials found on a site; 
information contained in the MATERIAL table. The data are also used in the exploration 
modules of Geotec.  
 
The key for the records consists of the fields Site, Type and Material.  

• Site will generally be the dummy site named SPEC to define the normalized materials. The 
user can also modify the materials for specific sites.  
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• Type shows a list of 4 values from the LIST_ENG table: backFill, Strata, Unified and 
eXcavation.  

• Material is the material code, with up to 20 characters.  

• A description of the material can be added with 255 characters.  

• Color is used to define a specific color for the material. Double-click in the field and a color 
definition window opens to ease the color selection. A value is required.  

• The material cost per cubic meter is entered (in $). 

• Depth indicates the top depth where the material layer is found.  

• Batter is the excavation batter. 
 

 

Figure 2-9 - Material entry form 
 
For each site, the materials of type Fill used in its cross-sections are copied in the 
MATERIALS table for the current site, allowing the user to adjust the color and cost of 
the materials for each project. 
 
 

9. COMPONENT 

The Component entry form shows the different components of a dike and their associated 
color; information contained in the COMPONENT table. Values are automatically added in the 
databases.   

• The key for the records consists of the ZID field. The order should not be changed; it is 
important during the creation of the cross sections of the dike.  

• The color of each component can be modified by double-clicking in the field. A color 
definition window is then opened to ease the color selection. A value is required.  

• A description of each component is displayed. It can be modified, but should remain explicit 
because it is with their description that the components are selected in the typical section 
window.  
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Figure 2-10 - Component entry form 
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